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This section of the User’s Guide provides instruction on using the Municipal Solid Waste 
module of the State Inventory Tool (SIT), and describes the methodology used for 
estimating greenhouse gas (GHG) emissions from municipal solid waste management at the 
state level.  
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1.1 GETTING STARTED 

The Municipal Solid Waste module was developed using Microsoft® Excel 2000.  While the 
module will operate with older versions of Excel, it functions best with Excel 2000 or later.  
If you are using Excel 2007 or later, instructions for opening the module will vary as 
outlined in the Excel basics below. Some of the Excel basics are outlined in the sections 
below.  Before you use the Municipal Solid Waste module, make sure your computer meets 
the system requirements.  In order to install and run the Municipal Solid Waste module, you 
must have: 

• IBM-PC compatible computer with the Windows 95 operating system or later; 

• Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

 Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  To check this setting, launch Microsoft Excel before opening the 
Municipal Solid Waste module.  Go to the Tools menu and select “Options...” Click on the 
“Calculations” tab and make sure that the radio button next to “Automatic” is selected, and 
then click on “OK” to close the window.  The security settings (discussed next) can also be 
adjusted at this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu.   

 Microsoft Excel Security 

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security 
set to medium (recommended) or low (not recommended).  To change this setting, launch 
Microsoft Excel before opening the Municipal Solid Waste module.  Once in Excel, go to the 
Tools menu, click on the Macro sub-menu, and then select “Security” (see Figure 1).  The 
Security pop-up box will appear.  Click on the “Security Level” tab and select medium.  
When set to high, macros are automatically disabled; when set to medium, Excel will give 
you the choice to enable macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros.  Macros must be enabled in order for the Municipal Solid Waste module to 
work.  Once they are enabled, the module will open to the control worksheet.  A message 
box will appear welcoming the user to the module.  Clicking on the “x” in the upper-right-
hand corner of the message box will close it. 

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security 
Warning appears above the formula box in Excel when the Municipal Solid Waste module is 
initially opened. The Security Warning lets the user know that some active content from the 
spreadsheet has been disabled, meaning that Excel has prevented the macros in the 
spreadsheet from functioning.  Because SIT needs macros in order to function properly, the 
user must click the “Options” button in the security message and then select, “Enable this 
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content” in the pop-up box. Enabling the macro content for the SIT in this way only enables 
macros temporarily in Excel but does not change the macro security settings.  Once macros 
are enabled, a message box will appear welcoming the user to module.  Click on the “x” in 
the upper right-hand corner to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros.  To change the setting, first exit out 
of the Municipal Solid Waste module and re-launch Microsoft Excel before opening the 
Municipal Solid Waste module.  Next, click on the Microsoft Excel icon in the top left of the 
screen. Scroll to the bottom of the menu and select the “Excel Options” button to the right 
of the main menu. When the Excel Options box appears, select “Trust Center” in left hand 
menu of the box.  Next, click the gray “Trust Center Settings” button.  When the Trust 
Center options box appears, click “Macro Settings” in the left-hand menu and select “Disable 
all macros with notification.”  Once the security level has been adjusted, open the 
Stationary Combustion module and enable macros in the manner described in the preceding 
paragraph. 

 Viewing and Printing Data and Results 

The Municipal Solid Waste module contains some features to allow users to adjust the 
screen view and the appearance of the worksheets when they are printed.  Once a module 
has been opened, you can adjust the zoom by going to the Module Options Menu, and either 
typing in a zoom percentage or selecting one from the drop-down menu.  In addition, data 
may not all appear on a single screen within each worksheet; if not, you may need to scroll 
up or down to view additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the Municipal Solid Waste module are printed.  To do so, go to the File menu, and then 
select “Print Preview.”  Click on “Page Break Preview” and drag the blue lines to the desired 
positions (see Figure 2).  To print this view, go to the File menu, and click “Print.”  To return 
to the normal view, go to the File menu, click “Print Preview,” and then click “Normal View.” 

Figure 1.  Changing Security Settings 

 
 
 

Figure 2.  Adjusting Print Margins 

 

Drag cursor 
to resize page 
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1.2 MODULE OVERVIEW 

This User’s Guide accompanies and explains the Municipal Solid Waste module of the SIT.  
The SIT was developed in conjunction with EPA’s Emissions Inventory Improvement 
Program (EIIP).  Prior to the development of the SIT, EPA developed the States Workbook 
for estimating greenhouse gas emissions.  In 1998, EPA revisited the States Workbook and 
expanded it to follow the format of EIIP guidance documents for criteria air pollutants.  The 
result was a comprehensive, stepwise approach to estimating greenhouse gas emissions at 
the state level.  This detailed methodology was appreciated by states with the capacity to 
devote considerable time and resources to the development of emission inventories.  For 
other states, the EIIP guidance was overwhelming and impractical for them to follow from 
scratch.  EPA recognized the resource constraints facing the states and developed the SIT.  
The ten modules of the SIT corresponded to the EIIP chapters and attempted to automate 
the steps states would need to take in developing their own emission estimates in a manner 
that was consistent with prevailing national and state guidelines.   

Because most state inventories developed today rely heavily on the tools, User’s Guides 
have been developed for each of the SIT modules.  These User’s Guides contain the most 
up-to-date methodologies that are, for the most part, consistent with the Inventory of U.S. 
Greenhouse Gas Emissions and Sinks.  Volume VIII of the EIIP guidance is a historical 
document that was last updated in August 2004, and while these documents can be a 
valuable reference, they contain outdated emissions factors and, in some cases, outdated 
methodologies.  States can refer to Volume VIII of the EIIP guidance documents if they are 
interested in obtaining additional information not found in the SIT or the companion User’s 
Guide. 

The Municipal Solid Waste module 
calculates methane (CH4) 
emissions from landfilling of 
municipal solid waste (MSW) and 
carbon dioxide (CO2) and nitrous 
oxide (N2O) emissions from the 
combustion of MSW.  While the 
module provides default data for most inputs, if you have access to more comprehensive 
data sources, they should be used in place of the default data (see Box 1 for suggestions of 
possible data sources).  If using outside data sources, or for a more thorough understanding 
of the tool, please refer to the following Methodology section for data requirements and 
methodology. 

In landfills, CH4 and CO2 are produced from anaerobic decomposition of organic matter by 
methanogenic bacteria.  Organic waste first decomposes aerobically (in the presence of 
oxygen) and is then decomposed by anaerobic non-methanogenic bacteria, which convert 
organic material to simpler forms like cellulose, amino acids, sugars, and fats.  These simple 
substances are further broken down to gases and short-chain organic compounds (H2, CO2, 
CH3COOH, HCOOH, and CH3OH), which support the growth of methanogenic bacteria.  The 
bacteria further metabolize these fermentation products into stabilized organic materials 
and “biogas,” which consists of approximately 50 percent CO2 and 50 percent CH4 by 
volume.  Additionally, some landfills flare recovered landfill gas, which converts the CH4 
portion of the gas to CO2.  There are also some landfills that collect and burn landfill gas for 
electricity production or other energy uses (known as landfill-gas-to-energy projects, or 
LFGTE), which are treated similarly to landfills that flare their gas.  

Box 1: State Solid Waste Data Sources 
In-state sources, such as state departments of 
environmental protection, should be consulted first.  
Otherwise, default data provided by the Municipal Solid 
Waste module may be used. 
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Neither the CO2 emitted directly as biogas nor the CO2 emitted from combusting CH4 at 
flares is counted as an anthropogenic greenhouse gas (GHG) emission.  The source of the 
CO2 is primarily the decomposition of organic materials derived from biomass sources (e.g., 
crops, forests), and in the United States these sources are grown and harvested on a 
sustainable basis.  Sustainable harvesting implies that photosynthesis (which removes CO2 
from the atmosphere) is equal to decomposition (which adds CO2 to the atmosphere).   

Waste combustion emits both CO2 and N2O.  CO2 is produced from the oxidation of organic 
materials in waste, such as paper, food scraps, yard trimmings, and plastic.  As with CO2 
from biogas and oxidation of CH4, CO2 emissions from biogenic sources (e.g., paper and 
food scraps) are not counted in GHG inventories because they simply return CO2 that plants 
previously absorbed through photosynthesis to the atmosphere.  However, some CO2 is 
from nonbiogenic sources (e.g., plastic and rubber made from petroleum), and is thus 
counted in GHG emission inventories.  N2O is produced at the high temperature found in 
waste combustors by the combination of nitrogen (both nitrogen contained in the waste and 
nitrogen gas in the air) and oxygen gas in the air. 

Users should also note that an additional waste-related greenhouse gas sink, carbon storage 
from landfilled yard trimmings and food scraps, is accounted for in the Land-Use Change 
and Forestry module of the SIT.   
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1.2.1 Data Requirements 

To calculate GHG emissions from municipal solid waste management, the data listed in 
Table 1 are required inputs (again, note that defaults are available for most of these data). 

Table 1. Required Data Inputs for the Municipal Solid Waste Module 
Solid Waste Sectors  Input Data 
Landfills Amount of MSW landfilled in state from 1960 through the present OR 

from 1990 through the present (short tons) 

State population data, 1960 through the present 

Amount of CH4 flared/recovered at landfills (short tons) 

Industrial landfill CH4 emissions, as a percent of MSW landfill emissions 

Percent of landfill CH4 oxidized at the landfill surface (oxidation factor) 

Waste Combustion Fraction of plastics, synthetic rubber, and synthetic fiber that is oxidized 
in a combustion facility 

Amount of MSW combusted for 1990 through the present (short tons) 

Plastic Combustion  Polyethylene terephthalate (PET) as a proportion of all MSW discards 

High-density polyethylene (HDPE) as a proportion of all MSW discards 

Polyvinyl chloride (PVC) as a proportion of all MSW discards 

Low-density/linear low-density polyethylene (LDPE/LLDPE) as a proportion 
of all MSW discards 

Polypropylene (PP) as a proportion of all MSW discards 

Polystyrene (PS) as a proportion of all MSW discards 

Other plastic as a proportion of all MSW discards 

Synthetic Rubber 
Combustion  

Synthetic rubber durables as a proportion of all MSW discards 

Synthetic rubber clothing and footwear as a proportion of all MSW 
discards 

Other synthetic rubber non-durables as a proportion of all MSW discards 

Synthetic rubber containers and packaging as a proportion of all MSW 
discards 

Synthetic Fiber 
Combustion  

Synthetic fiber as a proportion of all MSW discards 

 

1.2.2 Tool Layout 

Because the methodology of the Municipal Solid Waste module is complex, it is important to 
understand the module’s overall design.  The layout of the Municipal Solid Waste module 
and the purpose of its worksheets are presented in Figure 3.  
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Figure 3.  Flow of Information in the Municipal Solid Waste Module 

 

1.3 METHODOLOGY 

This section provides a guide to using the Municipal Solid Waste module of the SIT to 
estimate GHG emissions from municipal solid waste management.  The two sectors within 
the Municipal Solid Waste module, landfills and combustion, are treated separately.  Steps 4 
through 8 address the estimation of landfill CH4, while Step 9 deals with combustion. 

The following steps are involved in estimating emissions using the Municipal Solid Waste 
module: (1) select a state; (2) describe and enter state disposal information; (3) enter 
population data; (4) view preliminary CH4 emissions from landfills; (5) adjust CH4 emissions 
for the amount that is flared; (6) adjust for the amount of CH4 recovered at landfill-gas-to-
energy plants; (7) estimate CH4 generated at industrial landfills; (8) select landfill CH4 
oxidation factor; (9) fill in the variables used for waste combustion; (10) complete the CO2 
from synthetic rubber combustion worksheet; (11) complete the CO2 from synthetic fiber 
combustion worksheet; (12) complete the CO2 from the combustion of synthetic fibers 
worksheet; (13) review estimates on the N2O from MSW combustion worksheet; (14) 
review estimates on the CH4 from MSW combustion worksheet; (15) review summary 
information; and (16) export data.  Most of these steps take place on the control worksheet.  
The Municipal Solid Waste module will automatically calculate emissions after you make 
choices on the control worksheet and enter the required data on the individual sector 
worksheets.  The tool provides default sector data for most sectors. 
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Step (1) Select a State  

To begin, select the state you are interested in evaluating.  By selecting a state, the rest of 
the tool will automatically reset to reflect the appropriate state default data and 
assumptions for use in subsequent steps of the tool.  

Step (2) Describe and Enter State Disposal Information  

On the control worksheet, select the radio button that corresponds to the data you would 
like to use as shown in Figure 4.  There are three data options for entering waste disposal 
data:   

Option 1: If you have state-specific information on waste disposal from 1960 to the 
present, then no further disposal or population (see Step (3)) data are needed. 

Option 2: If you have state data on waste disposal for 1990 through the present, but 
not dating back to 1960, the module will estimate waste disposal using historical 
population data and national per capita landfilling rates.   

Option 3: If do not have state-specific disposal data, you may use the default 
disposal data already loaded into the module.  Default disposal data were estimated 
by allocating national waste disposal data (U.S. EPA 2019) to the state level on the 
basis of a state’s historical population (U.S. Census 2019).   

Clicking either of the first two user-entered data options will take you directly to a disposal 
data entry worksheet where you will enter annual state disposal into the yellow input cells.  
If you choose to use the available default disposal data provided in the module, you may 
navigate to the data-entry worksheet using the gray “View / Enter Data” arrow to the right 
of the selection buttons. 

The uncertainty associated with the three state disposal options varies.  The range of 
uncertainty represented by these three options is highly variable.  Option 1 is preferable, if 
the state-specific data entered into the module is well-documented and comprehensive.  
Option 2 attempts to leverage near-term historical data and to scale national information on 
per capita disposal, state population, and national population information to back cast waste 
disposal estimates.  This approach draws on several assumptions, namely that per capita 
generation in the state is the same as per capita generation at the national level.  Option 3 
has the least reliance on state information, making it the easiest, but potentially the least 
certain of the three options.     

The module uses a statistical model, known as a first order decay (FOD) model, to calculate 
landfill emissions.  In the FOD model, the CH4 emission rate is a function of the quantity of 
waste deposited in landfills (in short tons) over the previous 30 years.   
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Figure 4.  Example of Steps 1 through 4 on the Control Worksheet 

  

Step (3) Enter Population Data 

Unless you have entered disposal data for 1960 through the present, state population data 
will be required to calculate emissions.  The module automatically uses the default 
population data (from U.S. Census).  If you want to use population data from another 
source, click on the radio button indicating you would like to use your own data.  This action 
will automatically take you to the population data entry worksheet; you may also navigate 
to this worksheet using the gray arrow (“View / Enter Data”) to the right of the selection 
buttons, as shown in Figure 4. 

Landfills 

Step (4) View Preliminary CH4 Emissions from Landfills 

Once you have made your selections and entered data for the previous three steps, you 
may view preliminary calculations of CH4 emissions from MSW landfills in your state by 
clicking on the gray arrow that says “Go to the Calculations Sheet.”  This worksheet shows 
the preliminary results of the FOD model calculations for MSW.  These calculations are 
considered preliminary because CH4 emissions for the amount collected and burned and the 
amount oxidized at the surface of the landfill is considered in later steps.  The FOD model 
estimates the potential CH4 emissions that occur during the inventory year, but which are 
associated with the waste landfilled over the past thirty years, using Equation 1.   

…or choose the 
default data 

 

Select button corresponding to the 
type of disposal data you have… 

Choose a state 

Choose default or 
other population 

data 

View preliminary CH4 
emission calculations 

 

Go to data entry 
sheets 
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Equation 1.  First Order Decay Model Equation 
 

 
 
 
As the equation shows, emissions vary not only by the amount of waste present in the 
landfill, but also by the CH4 generation rate (k).  The CH4 generation rate varies according 
to several factors pertaining to the climate in which the landfill is located and is 
automatically chosen based on the selected state from Step (1).  Figure 5 shows the 
worksheet where the FOD model is applied.  It is not necessary to enter any information on 
this worksheet, as its purpose is to clarify how the FOD model is applied to the previously 
entered data. 

Figure 5.  Example of the First Order Decay Model Calculations Worksheet 

 

 

 

QTx = A × k × Rx × Lo × e-k(T - x)  

Where,    QTx = Amount of CH4 generated in year T by the waste Rx, 
                T = Current year 
                x = Year of waste input 
                A = Normalization factor (1-e-k)/k 
                k = CH4 generation rate (yr-1) 
                Rx = Amount of waste landfilled in year x 
                Lo = CH4 generation potential 



Module 9 – Municipal Solid Waste Module           September 2020 

State Greenhouse Gas Inventory Tool User’s Guide for the Municipal Solid Waste Module           
  1.11 

Step (5) Adjust CH4 Emissions for Amount of CH4 Flared 

The control worksheet offers three options for adjusting the module to reflect the amount of 
CH4 that is flared:  

Option 1: If you have state-specific data on short tons of CH4 flared, you may enter 
these data by clicking on the corresponding radio button, as shown in Figure 6, and 
then entering your data on the Flaring worksheet;  

Option 2: If you would like to use available default data provided in the module, 
select to use the default amount of CH4 flared, which is based on U.S. EPA (2020a) 
data; or  

Option 3: If you do not want to account for flaring of landfill gas in your state, you 
may choose to omit this section. 

Figure 6.  Example of Steps 5 through 8 on the Control Worksheet 

 

Gas collection systems have been put in place at many landfills.  At some landfills the CH4 
collected by these systems is flared.  As explained in the Module Overview, the CO2 
produced by flaring is not counted as anthropogenic GHG emissions under the accounting 
system used in the module, so the quantity of CH4 collected and flared may be subtracted 
from the total amount of MSW landfill CH4 produced, as shown in Equation 2.  Likewise, CH4 
that is collected and used to create electricity may also be subtracted, as discussed in Step 
(6) below.   

Choose type of 
LFGTE data 

 

Choose type of CH4 flaring data 

Enter emissions from 
industrial landfills % 

Go to data entry 
sheets 

Check box for default 

 

Enter CH4 oxidation 
factor 
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Equation 2.  Net CH4 Emissions from Landfills 

 
 

Step (6) Adjust for Amount of CH4 Recovered at Landfill-Gas-to-Energy Plants 

As mentioned in Step (5), some landfills collect and burn landfill gas to produce energy.  
Such operations are known as landfill gas to energy (LFGTE) plants.  The CH4 collected and 
burned as part of that landfill gas should be subtracted from the total CH4 generation, as 
shown in Equation 2.   

The following three options for adjusting CH4 emissions for the amount recovered at LFGTE 
plants are provided on the control worksheet:   

Option 1: If you have state-specific data on short tons of CH4 burned in LFGTE 
facilities, you may enter those data by clicking on the corresponding radio button, as 
shown in Figure 6, and then entering your data on the LFGTE worksheet; 

Option 2: If you would like to use default data provided in the module, select to use 
the default amount of CH4 recovered at LFGTE plants, which is based on U.S. EPA 
(2020a) data; or 

Option 3: If you do not account for CH4 recovered at LFGTE plants, you may choose 
to omit this section and not account for LFGTE operations. 

Step (7) Estimate CH4 Generated at Industrial Landfills 

Up to this point, all information entered in the module refers to CH4 generated from MSW 
landfills.  However, CH4 is also generated from waste deposited in non-hazardous industrial 
landfills.  Although CH4 generation from non-hazardous industrial landfills is believed to be 
small relative to that from MSW landfills, industrial landfill CH4 generation is still a 
significant source of CH4 emissions.  CH4 generation from industrial landfills does not 
include CH4 generation from industrial waste disposed of into MSW landfills, as these 
emissions have already been accounted for in the module.   

The quantity of waste in industrial landfills and the quantity of CH4 that it generates must 
be estimated due to a lack of data.  Based on estimates of the quantity of waste in place at 
industrial landfills and on the estimated organic content of industrial landfills compared to 
MSW landfills, U.S. EPA (1993) estimated that CH4 generation from industrial landfills in the 
United States is approximately 7 percent of CH4 generation from MSW landfills in the United 
States, prior to adjusting for flaring and recovery or oxidation.  If you have outside 
information, you may adjust this percent in the yellow box, as shown in Figure 6. 

 

 

 

 

Preliminary Net CH4 Emissions =  

Total CH4 Generated – CH4 Flared or Recovered for Energy – CH4 Oxidized in Landfill 



Module 9 – Municipal Solid Waste Module           September 2020 

State Greenhouse Gas Inventory Tool User’s Guide for the Municipal Solid Waste Module           
  1.13 

Step (8) Select Landfill CH4 Oxidation Factor 

The default assumption in Step (8) of the control worksheet is that 10 percent of the CH4 
generated that is not flared or recovered is oxidized in the soil (this holds for industrial 
landfills also).  To use the default percent, click on the check box.  To use your own 
oxidation factor, enter it in the yellow box as shown in Figure 6. If the user-specific inputs 
do not match the default data in the control worksheet (i.e., the default value is 
overwritten), the text will appear red. 

Regardless of whether a landfill gas recovery system is in place, uncollected CH4 will pass 
upward through the landfill cover or surrounding soils, where it may be oxidized (Whalen, 
Reeburgh and Sandbeck 1990).  The amount of oxidation that occurs is uncertain and 
depends on latitude (affecting surface soil temperature), soil characteristics, and other 
factors.   

Waste Combustion 

Step (9) Fill in the Variables Used for Waste Combustion 

As described in the Module Overview, combustion of fossil-fuel derived materials in MSW 
results in emissions of anthropogenic CO2, N2O, and CH4.  To develop an estimate of CO2 
emissions, the module calculates combustion of the fossil-derived carbon in MSW for three 
waste categories: plastics, synthetic fibers (e.g. textiles), and synthetic rubber (U.S. EPA 
2019).  The defaults in the Municipal Solid Waste module use information on the typical 
composition of discards in the U.S. solid waste stream to estimate the mass of each of these 
waste types that is combusted and estimates the proportion of each material that comprises 
fossil carbon.  The module defaults also assume that 98 percent of the fossil carbon is 
converted to CO2 in the combustion process (with the balance remaining in the ash).   

Some of the data inputs required to complete estimates of GHG emissions from waste 
combustion are entered on the control worksheet as shown in Figure 7, and the remaining 
data inputs are entered on individual calculation worksheets for each type of material, as 
well as for N2O and CH4 emissions.  

 Fraction of Waste Oxidized 

Enter the fraction of carbon that is oxidized for each material type in the yellow boxes on 
the control worksheet as shown in Figure 7.  To use the default percent oxidized (98 
percent); use the check boxes to the right of the yellow cells. If the user-specific inputs do 
not match the default data in the control worksheet (i.e., the default value is overwritten), 
the text will appear red. 
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Figure 7.  Example of Steps 9 through 11 on the Control Worksheet 

 

 Default or User-Entered Data 

The module allows you to enter your own data on short tons of waste combusted in-state 
for the years 1990 through the present, or to use the default data, which is based on 
BioCycle (1991-2008).  Choose the appropriate radio button; if you choose to enter your 
own data, this action will take you to the data entry worksheet.  You may also navigate to 
this sheet using the gray “View / Enter / Edit Data” arrow to the right of the buttons.  After 
completing this section of the control worksheet, go on to the combustion sector calculation 
worksheets. 

Step (10) Complete the CO2 from Plastics Combustion Calculation Worksheet 

There are separate worksheets for each of the three types of fossil-derived MSW (plastics, 
synthetic rubber, and synthetic fiber) and each of the worksheets is similar in layout.  An 
example of the plastics combustion worksheet is shown in Figure 8.  Emissions are 
calculated using the following equation: 

Equation 3.  CO2 Emissions from Combustion 
 

 

CO2 Emissions (MTCO2E) =  
Material as Proportion of all Discards (%) × Total MSW Combusted (short tons) × Carbon 

Content (%) × Fraction Oxidized (%) × 44/12 (CO2 to C ratio) × 0.9072 (short tons to 
metric tons conversion) 

Choose type of 
combustion data 

 

Enter percent oxidation in 
combusted wastes 
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Check boxes for default 

 

Export data 
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On the plastics combustion worksheet, enter the proportion of each type of plastic (PET, 
HDPE, PVC, LDPE/LLDPE, PP, PS, and other) as a percent of total discards in the blue cells.  
The default data are from U.S. EPA (2019), and may be selected by clicking the check box 
for each year, as shown in Figure 8, or by clicking the box “Select All Defaults.”  Total tons 
of waste combusted are drawn from the data you entered in Step (9); default carbon 
contents are provided for each type of plastic.  Once you have entered data for each year, 
you may proceed to the synthetic rubber combustion worksheet by clicking on the gray 
arrow at the top of the page. 

Figure 8.  Example of Plastics Combustion Calculation Worksheet 

 

Step (11) Complete the CO2 from Synthetic Rubber Combustion Calculation 
Worksheet 

The synthetic rubber combustion worksheet is identical to the plastic combustion worksheet, 
except that it calculates emissions for durable goods, non-durable goods (clothing and 
footwear, and other non-durables), and packaging and containers made of synthetic rubber.  
Enter the proportion of each type of rubber in the green cells as a percent of total discards, 
or select the default data (U.S. EPA 2019).  Once you have entered data for each year, you 
may proceed to the synthetic fiber combustion worksheet by clicking on the gray arrow at 
the top of the page. 

Step (12) Complete the CO2 from Synthetic Fiber Combustion Calculation 
Worksheet 

Again, this worksheet is identical to the worksheets for plastic and synthetic rubber 
combustion.  Enter synthetic fiber as a proportion of all discards, in the orange cells, or 

Combustion data from 
data entry worksheet 

 
Go to synthetic 

rubber worksheet 

Fraction oxidized from 
control worksheet 

 

Enter material as 
proportion of all discards 

 

Check box for default 
proportions 
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choose the default proportions.  The carbon content provided is a weighted average of the 
carbon contents of the major synthetic fibers used in the United States.  Once you have 
entered data for each year, you may proceed to the N2O from MSW combustion worksheet 
by clicking on the gray arrow at the top of the page. 

Step (13) Review Estimates on the N2O from MSW Combustion Calculation 
Worksheet 

This worksheet does not require any data inputs; it presents an example of how the 
emissions are calculated based on the following equation (the emission factor is from U.S. 
EPA 2020b): 

Equation 4.  N2O Emissions from Combustion 
 

 

Step (14) Review Estimates on the CH4 from MSW Combustion Calculation 
Worksheet 

This worksheet does not require any data inputs; it presents an example of how the 
emissions are calculated based on the following equation (the emission factor is from U.S. 
EPA 2020b): 

Equation 5.  CH4 Emissions from Combustion 
 

 

Step (15) Review Summary Information 

The steps above provide estimates of total emissions and reductions from municipal solid 
waste management.  The information from the control worksheet and data entry worksheets 
is collected on the summary worksheet, which displays results in million metric tons of 
carbon dioxide equivalent (MMTCO2E).  Figure 9 shows the summary worksheet that sums 
the emissions from all sectors in the Municipal Solid Waste module.  In addition, the results 
are displayed in graphical format at the bottom of the summary worksheets.  

CH4 Emissions (MTCO2E) =  
MSW Combusted (short tons) × 0.00002 (emission factor in tons N2O/ton MSW) × 25 

(CH4 GWP) × 0.9072 (short tons to metric tons conversion) 

N2O Emissions (MTCO2E) =  
MSW Combusted (short tons) × 0.00005 (emission factor in tons N2O/ton MSW) × 298 

(N2O GWP) × 0.9072 (short tons to metric tons conversion) 
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Figure 9.  Example of the Emissions Summary Worksheet in the Municipal Solid 
Waste Module 

 
 
Step (16) Export Data 

The final step is to export the summary data.  Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
GHG inventory for the state. 

To access the “Export Data” button, 
return to the control worksheet and 
scroll down to the bottom (15).  Click 
on the “Export Data” button and a 
message box will open that reminds 
the user to make sure all sections of 
the module have been completed.  If 
you make any changes to the 
Municipal Solid Waste module later, 
you will then need to re-export the 
results. 

Clicking “OK” prompts you to save the file.  The file is already named, so you only need to 
choose a convenient place to save the file.  After the file is saved, a message box will 
appear indicating that the data was successfully exported.   

While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running the entire module. 

Following data export, the module may be reset and run for another state.  Alternatively, 
you may run the remaining modules of the State Inventory Tool to obtain a comprehensive 
profile of emissions for your state.  

Note: the resulting export file should not be 
modified.  The export file contains a summary 
worksheet that allows users to view the results, as well as 
a separate data worksheet with an unformatted version of 
the results.  The second worksheet, the data worksheet, 
contains the information that is exported to the Synthesis 
Tool.  Users may not modify that worksheet.  
Adding/removing rows, moving data, or making other 
modifications jeopardize the ability of the Synthesis 
Module to accurately analyze the data.   
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1.4 UNCERTAINTY 

In the upper right-hand corner of the summary worksheet is a button: “Review discussion of 
uncertainty associated with these results.”  By clicking on this button, you are taken to a 
worksheet that discusses the uncertainty surrounding the activity data and emission factors, 
and how the uncertainty estimates for this source category affect the uncertainty of the 
emission estimates for your state. 

 
1.5 REFERENCES 

BioCycle. 1991-2008. “The State of Garbage in America: Annual Nationwide Survey.”  
BioCycle. 

U.S. Census Bureau. 2019.  2000-2019 Population.  U.S. Census Bureau, Washington, DC. 
Available online at: http://www.census.gov.  

U.S. EPA. 2019. Advancing Sustainable Materials Management Facts and Figures. Available 
online at: https://www.epa.gov/facts-and-figures-about-materials-waste-and-
recycling/advancing-sustainable-materials-management. 

U.S. EPA. 2020a. Landfill Gas-to-Energy Project Database 2020, Landfill Methane and 
Outreach Program. Obtained from EPA on July 20, 2020. State-level data are available 
online at: https://www.epa.gov/lmop/project-and-landfill-data-state.   

U.S. EPA. 2020b. Inventory of U.S. Greenhouse Gas Emissions and Sinks: 1990 – 2018.  
Office of Atmospheric Programs, U.S. Environmental Protection Agency. EPA 430-R-20-
002. Available online at: https://www.epa.gov/ghgemissions/inventory-us-greenhouse-
gas-emissions-and-sinks 

U.S. EPA.  1993. Anthropogenic Methane Emissions in the United States: Report to 
Congress.  Global Change Division, Office of Air and Radiation, U.S. Environmental 
Protection Agency, EPA/430-R-93-003.  Washington, DC. 

Whalen, S.C., W.S. Reeburgh, and K.A. Sandbeck.  1990. “Rapid Methane Oxidation in a 
Landfill Cover Soil,” Applied and Environmental Microbiology.  November 1990. 

 

http://www.census.gov/
https://www.epa.gov/facts-and-figures-about-materials-waste-and-recycling/advancing-sustainable-materials-management
https://www.epa.gov/facts-and-figures-about-materials-waste-and-recycling/advancing-sustainable-materials-management
https://www.epa.gov/lmop/project-and-landfill-data-state
https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-emissions-and-sinks
https://www.epa.gov/ghgemissions/inventory-us-greenhouse-gas-emissions-and-sinks

	1.1  Getting Started
	Microsoft Excel Settings
	Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to automatic calculation.  To check this setting, launch Microsoft Excel before opening the Municipal Solid Waste module.  Go to the Tools menu and select “Options...”...
	Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make sure that the box next to the “Automatic” option is checked from the pop-up m...
	Microsoft Excel Security
	Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security set to medium (recommended) or low (not recommended).  To change this setting, launch Microsoft Excel before opening the Municipal Solid Waste module.  Once in Excel,...
	When Excel security is set to medium, users are asked upon opening the module whether to enable macros.  Macros must be enabled in order for the Municipal Solid Waste module to work.  Once they are enabled, the module will open to the control workshee...
	Excel 2007 and Later: If Excel’s security settings are set at the default level a Security Warning appears above the formula box in Excel when the Municipal Solid Waste module is initially opened. The Security Warning lets the user know that some acti...
	If the Security Warning does not appear when the module is first opened, it may be necessary to change the security settings for macros.  To change the setting, first exit out of the Municipal Solid Waste module and re-launch Microsoft Excel before op...
	Viewing and Printing Data and Results

	1.2 Module Overview
	1.2.1 Data Requirements
	1.2.2 Tool Layout

	1.3 Methodology
	Step (1) Select a State
	Step (2) Describe and Enter State Disposal Information
	Step (3) Enter Population Data
	Landfills
	Step (4) View Preliminary CH4 Emissions from Landfills
	Step (5) Adjust CH4 Emissions for Amount of CH4 Flared
	Step (6) Adjust for Amount of CH4 Recovered at Landfill-Gas-to-Energy Plants
	Step (7) Estimate CH4 Generated at Industrial Landfills
	Step (8) Select Landfill CH4 Oxidation Factor
	Waste Combustion
	Step (9) Fill in the Variables Used for Waste Combustion
	Fraction of Waste Oxidized
	Default or User-Entered Data
	Step (10) Complete the CO2 from Plastics Combustion Calculation Worksheet
	Step (11) Complete the CO2 from Synthetic Rubber Combustion Calculation Worksheet
	Step (12) Complete the CO2 from Synthetic Fiber Combustion Calculation Worksheet
	Step (13) Review Estimates on the N2O from MSW Combustion Calculation Worksheet
	Step (14) Review Estimates on the CH4 from MSW Combustion Calculation Worksheet
	Step (15) Review Summary Information
	Step (16) Export Data

	1.4 Uncertainty
	1.5 References

